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Introduction Installing
SketchBook Designer

Before you begin: checklist
Review the following checklist before installing and licensing  SketchBook
Designer.
■ Review the requirements section for your platform:

System requirements (Windows) (page 3)

The most up-to-date information on specific hardware system qualifications
for your computer can be found on the Autodesk Web site:

http://www.autodesk.com/qual-charts

Your computer system must meet specific hardware and software
requirements for you to successfully install and run  SketchBook Designer.

Autodesk does not support hardware and software configurations that do
not meet these requirements.

■ If you do not have administrator privileges on your computer,
contact your system administrator.

You must have administrator privileges to install  SketchBook Designer. (You
do not need to be an administrator to launch  SketchBook Designer after it
has been installed.)

■ Uninstall  SketchBook Designer before installing the same
SketchBook Designer version as the one installed. See

Uninstall SketchBook Designer  (page 15)

If you have a previous version of  SketchBook Designer on your system, you
can choose to keep it or uninstall it. However, you must uninstall before
installing the same  SketchBook Designer version as the one installed.

1
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■ Before installing:
■ Close all programs

■ Disable any virus detection software

To avoid any conflicts when installing  SketchBook Designer, we
recommend that you close all other programs and disable virus detection
software before launching the installer.

■ Determine how you will implement licensing.

During the installation process, you must enter your license type and
license information to initialize the process. Will the licensing be local to
the machine or are you using a license server? For more information, see
Licensing SketchBook Designer (page 17).

You are now ready to install  SketchBook Designer. Please follow your
platform-specific installation instructions:

Installing SketchBook Designer for Windows (page 3)
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Installing SketchBook
Designer for Windows

Installing  SketchBook Designer for Windows
This chapter describes the prerequisites for installing and describes how to install
SketchBook Designer for Windows, as well as uninstalling and options.

This chapter also includes information for installing  SketchBook Designer for
AutoCAD.

NOTE

These general instructions apply to all products in the installer, but add-ins for
other applications that are included with this installer may have different system
and installation requirements. This installer will not install the required host
applications for these items.

To prepare for installation, you should review the system requirements,
understand administrative permission requirements, locate your  SketchBook
Designer serial number and product key, and close all running applications.
Complete these tasks, and you are ready to begin installing  SketchBook Designer.

System requirements for Windows
Autodesk certifies certain system configurations as meeting the requirements
to work with  SketchBook Designer software. Check that your system meets the
following minimum requirements.

2
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NOTE

The system requirements for  SketchBook Designer for AutoCAD are identical
to the host version of AutoCAD. The following system requirements only
apply to  SketchBook Designer.

You can examine your system capabilities using system diagnostic tools. Select
Start > Programs > Accessories > System Tools > System Information.

Hardware requirements

■ An 800MHz CPU

■ 2 GB RAM (4 GB or more is highly recommended)

■ A DVD-ROM drive on this machine or a shared DVD drive accessed via a
networked mapped drive

■ An input device for drawing and sketching. Intuos 3 or higher tablet or
Wacom Cintiq® active tablet highly recommended, using a tablet driver
of 6.1.2-5 or higher.

Graphics requirements

DirectX 9.0 capable graphics card with 256 MB or greater dedicated video
memory with a minimum screen resolution of 1280 x 1024 with True Color
or 32-bit Color.

See Set up your graphics card (Windows) (page 5).

Operating system requirements

■ Microsoft® Windows Vista® Enterprise Service Pack 2 (SP2), 32-bit and
64-bit

■ Microsoft® Windows Vista Business Service Pack 2 (SP2), 32-bit and 64-bit

■ Microsoft® Windows Vista Ultimate Service Pack 2 (SP2), 32-bit and 64-bit

■ Microsoft® Windows 7 Enterprise 32-bit and 64-bit

■ Microsoft® Windows 7 Ultimate 32-bit and 64-bit

■ Microsoft® Windows 7 Professional 32-bit and 64-bit

■ Microsoft® Windows® XP Professional Service Pack 2 (SP2) or later, 32-bit
and 64-bit Edition*

*Certain elements of the application will have a different appearance when
compared with Windows Vista or Windows 7.
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■ Microsoft Windows® XP, Windows® Vista, Windows® 7

NOTE  The installer will automatically detect whether your system is 32 or 64-bit,
and will install the appropriate version of the software. The 32-bit software version
cannot be installed on a 64-bit OS.

Disk space requirements

■ 5 GB of hard drive space for installation

Other software

■ Autodesk AutoCAD 2011 is required to install and use the  SketchBook
Designer for AutoCAD add-in. For more information on the add-in and
on AutoCAD software, see http://www.autodesk.com/autocad

■ Adobe® Acrobat® Reader version 6 or higher, is required to view the PDF
documentation. You can download a free copy of Acrobat Reader from
http://www.adobe.com.

■ Microsoft Internet Explorer® 6 or later Web browser is required to view
the online help.

■ Flash plug-in to view animated tutorial sequences in your browser. Free
plug-ins are available from http://www.flash.com.

■ If a Wacom table is being used, update to the latest Wacom driver software
(http://www.wacom.com).

Graphics card setup

The graphics display performance in  SketchBook Designer depends on the
quality of your graphics card and on the option settings in the Display
Properties window of your graphics card.

To learn the option settings for graphics cards that are certified for use with
SketchBook Designer, see the latest qualification chart, at
http://www.autodesk.com/qual-charts.

If your graphics card is not certified, perform the following steps. These steps
offer general guidelines only because each manufacturer has a unique set of
display options.

System requirements for Windows | 5
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To set up your graphics card.

1 Right-click your desktop, select Properties, then select the Settings
tab in the Display Properties window.

2 From the Color quality menu, select 32-bits of color for best color
quality in displayed images.

3 Drag the Screen resolution slider to the best display resolution
supported by your hardware. The higher you set the display resolution,
the more graphics card main memory you need. This is called VRAM on
some computers.

Administrative Permission Requirements
To install  SketchBook Designer, you must have administrator permissions.
You do not need to have domain administrative permissions. See your system
administrator for information about administrative permissions.

You do not need administrator permissions to run  SketchBook Designer. You
can run the program as a limited user.

Locating Your Serial Number and Product
Key

When you install  SketchBook Designer, you are prompted for your serial
number and product key in the Product and User Information page, or the
option of installing the product in trial mode. You may enter your product
information at any time during your trial mode period if you opt to install
the product in that mode.

NOTE  The licensing and activation of both  SketchBook Designer and the add-in
SketchBook Designer for AutoCAD is shared. Activating one will automatically
activate the other. Also, their trial periods are linked, so that a trial for one will
start the trial period for the other, even if it is not yet installed.

The serial number and product key are located on the outside of the product
packaging, or in the Autodesk Upgrade and Licensing Information email. Make
sure to have these available before you install the program so that you don't
have to stop in the middle of the installation.
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The serial number must contain a three-digit prefix followed by an eight-digit
number. The product key consists of five characters.

NOTE When you enter the serial number and product key, if you make a mistake,
an X will appear next to the entry. If it's correct, a check appears.

The information you enter is permanently retained with the product. Because
you can't change this information later without uninstalling, take care when
entering the information. To review this product information later while the
product is running, on the InfoCenter toolbar, click the drop-down arrow
next to the Help button (the question mark). Then click About  SketchBook
Designer.

NOTE  If you have lost your serial number or product key, contact the Autodesk
Business Center (ABC) at 800-538-6401 for assistance.

Installing and Running the Product
To use the product, you must install the product, register and activate it, and
then launch it. You must have administrative permissions to install
SketchBook Designer.
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NOTE

SketchBook Designer for AutoCAD 2012 requires that AutoCAD 2012 already
be installed on the system for this software to be installed.

This section provides instructions for installing and activating  SketchBook
Designer for an individual user on a stand-alone computer. For information
about installing network-licensed versions of the program, see Network
Licensing (page 28).

Installing  SketchBook Designerand
SketchBook Designer for AutoCAD

The  SketchBook Designer Installation wizard contains all installation-related
material in one place. From the Installation wizard, you can access installation
documentation, change the installer language, select a language for your
product (if supported), and install supplemental tools.
■ Review the installation documentation. It is recommended that

you take the time to familiarize yourself with the complete installation
process before you install  SketchBook Designer. You can access information
on installation from the installation wizard by selecting the Read this
Documentation option, the Documentation and information links on the
install dialogs, or through the Help system.

For late-breaking information, it is also recommended that you review the
product Readme.

To install  SketchBook Designer using default values on a stand-alone
computer

Using the default installation settings is the fastest way to install  SketchBook
Designer on a single, stand-alone system. A default installation does the
following:
■ Uses a Typical installation, which installs the most common application

features.

■ Installs  SketchBook Designer to the default install path of C:\Program
Files\Autodesk\ SketchBook Designer2012.

■ Installs  SketchBook Designer for AutoCAD to the default install path of
C:\Program Files\Autodesk\ SketchBook Designer for AutoCAD2012

1 Start the  SketchBook Designer Installation wizard.
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2 On the initial page, select a language for Product language. Click Install.

3 On the Select the Products to Install page, select your product(s) and the
product language. Click Next.

4 Review the Autodesk software license agreement. Click I Accept, and
then click Next.

5 On the Product Information page, enter your user information, serial
number, and product key. Click Next.

NOTE When you enter the serial number and product key, if you make a
mistake, an X will appear next to the entry. If it's correct, a check appears.
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WARNING After you click Next, you cannot change the information entered
on this page unless you uninstall the product.

6 On the Begin Installation page, select Install, then select Yes to the
configuration warning message. This will install the product with the
default configuration.

7 On the Installation Complete page, you can view the installation log
and  SketchBook Designer Readme.

8 Click Finish.

To install  SketchBook Designer using customized values on a
stand-alone computer

With this method, you can customized your installation.

1 Start the  SketchBook Designer Installation wizard.

2 On the initial page, select a language for the Product language. Click
Install.

3 On the Select the Products to Install page, select your product(s) and the
product language. Click Next.

4 Review the Autodesk software license agreement. Click I Accept, and
then click Next.

5 On the Product Information page, enter your user information, serial
number, and product key. Click Next.

WARNING After you click Next, you cannot change the information entered
on this page unless you uninstall the product.

6 On the Begin Installation page, click Configure.
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7 On the Select the Installation Type page, specify the following:
■ Installation Type. Select Typical to install the most common

application features. Select Custom to install only the application
features that you select from the Select Features to Install list.

■ Create the Desktop Shortcut for  SketchBook Designer - <Language>. Clear
the check box if you do not want to create a shortcut to the program.

■ Product Install Path - Specify the drive and location where you want
to install  SketchBook Designer.

Click Next.

8 On the Include Service Pack page, specify whether to include available
service packs. The installer automatically checks autodesk.com for available
updates.

9 Click another product tab to configure another product, or click Next
and then Configuration Complete to return to the Begin Installation
page. Click Install.

NOTE To retain a copy of your configuration settings, click Copy to
Clipboard.

10 On the Installation Complete page, you can view the installation log

11 Click Finish.
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You have successfully installed  SketchBook Designer. You are now ready to
register your product and start using the program. To register the product,
start  SketchBook Designer and follow the on-screen instructions.

Activate the software from a serial number

The first time you launch  SketchBook Designer, the product activation window
appears.

1 Click Enter Serial Number to enter your serial number and product
key.

WARNING  When pasting the serial number emailed to you, ensure there
are no spaces anywhere within, before, or after the number. A space will
cause the installation to fail. If in doubt, manually enter the serial number.

2 Click OK.

Entering a serial number

Besides going through the procedure above, there is another place where a
serial number can be entered.

1 Select Help > Enter Serial Number to open the  SketchBook Designer
Product Activation window.

2 Enter the serial number and product key from the product packaging or
online purchase confirmation, then click OK.

NOTE If you don’t have a serial number, you can still use SketchBook by
clicking Use Trial to install a 15 non-consecutive day trial version.

Register and Activate  SketchBook Designer

The first time you start  SketchBook Designer, the Product License Activation
wizard is displayed. You can either activate  SketchBook Designer at that time,
or Try  SketchBook Designer and activate it later. Until you register and enter
a valid activation code for  SketchBook Designer, you are operating the program
in trial mode and the Product License Activation wizard is displayed for 30
days from the first time that you run the program.
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If after 30 days of running  SketchBook Designer in trial mode you have not
registered and provided a valid activation code, your only option is to register
and activate  SketchBook Designer. You will not be able to run in trial mode
after the 30 days expires. Once you register and activate  SketchBook Designer,
the Product License Activation wizard is no longer displayed.

NOTE

The licensing and activation of both  SketchBook Designer and the add-in
SketchBook Designer for AutoCAD are shared. Activating one will automatically
activate the other. Also, their trial periods are linked, so that a trial for one
will start the trial for the other, even if not yet installed.

The fastest and most reliable way to register and activate your product is by
using the Internet. Simply enter your registration information and send it to
Autodesk over the Internet. Once you submit your information, registration
and activation occur quickly.

To register and activate  SketchBook Designer

1 Do one of the following:
■ (Windows XP) Click Start menu  ➤  Programs  ➤  Autodesk  ➤ 

SketchBook Designer  ➤  SketchBook Designer .

■ (Windows Vista and Windows 7) Click Start menu  ➤  All Programs
 ➤  Autodesk  ➤  SketchBook Designer  ➤  SketchBook Designer .

■ If the  SketchBook Designer for AutoCAD add-in is installed, you
must launch AutoCAD to access the add-in.

NOTE

Registering and activating either  SketchBook Designer or  SketchBook
Designer for AutoCAD will register and activate both products on
your system, even if they are installed at different times.

2 In the  SketchBook Designer Product License Activation wizard, select
Activate, and then click Next.

This starts the activation process.

3 Click Register and Activate (Get an Activation Code).

4 Click Next and follow the on-screen instructions.

If you do not have Internet access, or if you want to use another method
of registration, you can register and activate  SketchBook Designer in
one of the following ways:
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Email Create an email message with your registration information and
send it to Autodesk.

Fax or Post/Mail Enter your registration information, and fax or mail
the information to Autodesk.

Launch  SketchBook Designer

Assuming that you followed all of the previous steps outlined in this
installation section, you can launch  SketchBook Designer and start taking
advantage of its new and updated features. For more detailed information
about the new features, learning videos, online Help, or  SketchBook Designer
services and support, see the Welcome screen after you launch the product.

You can start  SketchBook Designer in the following ways:
■ Desktop shortcut icon. When you install  SketchBook Designer, an

SketchBook Designer shortcut icon is placed on your desktop unless you
cleared that option during installation. Double-click the  SketchBook
Designer icon to start the program.

■ Start menu. On the Start menu (Windows XP), click Programs or
(Windows Vista and Windows 7) All Programs  ➤  Autodesk  ➤  SketchBook
Designer  ➤  SketchBook Designer .

■ Location where  SketchBook Designer is installed. If you have
administrative permissions, you can run  SketchBook Designer in the
location where you installed it. If you are a limited-rights user, you must
run  SketchBook Designer from the Start menu or from the desktop shortcut
icon. If you want to create a custom shortcut, make sure that the Start In
directory for the shortcut points to a directory where you have write
permissions.

Launch  SketchBook Designer for AutoCAD

If you have installed  SketchBook Designer for AutoCAD, you must launch
AutoCAD first to use the add-in and its features. For more detailed information
about the features, including learning videos, or  SketchBook Designer for
AutoCAD services and support, see the Online Help after you launch the
product.
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Uninstall  SketchBook Designer

When you uninstall  SketchBook Designer, all components are removed. This
means that even if you've previously added or removed components, or if
you've reinstalled or repaired  SketchBook Designer, the uninstall removes all
SketchBook Designer installation files from your system.

To uninstall  SketchBook Designer

1 Do one of the following:
■ (Windows XP) Click Start menu  ➤  Settings  ➤  Control Panel  ➤ 

Add or Remove Programs.

■ (Windows Vista and Windows 7) Click Start menu  ➤  Control Panel
 ➤  Programs and Features  ➤  Uninstall or Change a Program.

2 Then, do one of the following:
■ (Windows XP) In the Add or Remove Programs window, select

SketchBook Designer, then click Change/Remove.

■ (Windows Vista and Windows 7) In the Uninstall or Change a
Program window, select  SketchBook Designer, then click Uninstall.

The  SketchBook Designer Installation wizard re-opens in Maintenance
mode.

3 Click Uninstall.

4 On the Uninstall  SketchBook Designer  page, click Next to remove
SketchBook Designer from the system.

5 When informed that the product has been successfully uninstalled, click
Finish.

NOTE  Even though  SketchBook Designer is removed from your system, the
software license remains. If you reinstall  SketchBook Designer at some future time,
you will not have to register and re-activate the program.

Installing Multiple or Bundled Products

Some Autodesk packages are comprised of multiple products or are part of
multi-product bundles.

In the installation wizard, for packages containing multiple products, you can
choose which products and languages you want to install. During the install

Installing and Running the Product | 15



process, you are informed whether a copy of the software is already installed.
You are also warned if your system does not meet the minimum system
requirements for the product. Each product name is displayed on its own
tabbed panel; you can configure them individually.

If you purchased a package that is a multi-product bundle, such as an
educational or institutional package, you may have a package that includes
several Autodesk products. For these bundled packages, an Installer disc
contains information for all the products in the package. The Installer disc
helps you install all of the products.
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Licensing SketchBook
Designer

Licensing SketchBook Designer
This chapter describes how to receive and install a license, for either a
stand-alone installation or in a network-licensed installation.

NOTE  These instructions apply to both  SketchBook Designer and  SketchBook
Designer for AutoCAD. The availability of particular license types for each product
may vary.

License Types and Behaviors
Autodesk provides two main types of licenses:
■ A stand-alone license supports one or more Autodesk products for an

individual user. Similarly, a multi-seat stand-alone license supports a specific
number of users. While the software can be installed on additional computers
in your facility, the licensed number of users cannot be exceeded.

■ A network license supports a specific maximum number of users who are
connected to a network. A software utility known as the Network License
Manager (NLM) issues licenses to users, up to the number of licenses
purchased. At this point, no more computers can run the Autodesk product
until a license is returned to the NLM.

Autodesk supports dynamic product usage and license behaviors. You can
purchase a specific type of behavior with a specific license and change that
license at a later date without having to uninstall and reinstall the Autodesk
product.

3
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License usage types

NOTE All license types are available as stand-alone and network except for the
Student Portfolio license, which is available as stand-alone only.

Commercial A license for a product that was purchased commercially.

Not for Resale A license for a product that is not sold commercially.

Educational (EDU)/Institution A license designed specifically for educational
institutions.

Student Portfolio A license for students who are using an Autodesk product
as part of their curriculum.

License behaviors

Trial A license that allows individuals to run a product or suite in trial mode
for a specified time period, usually 30 days. The trial period starts the first
time you launch the product, or one of the products in the suite. You can
activate and register the license at any time, before or after the trial period
expires.

Permanent Allows permanent use of an Autodesk product.

Term Extendable Allows access to an Autodesk product for a limited time.
The term can be extended at any time.

Term Non-Extendable Allows access to an Autodesk product for a limited
time. The term cannot be extended.

Activation
You can activate your Autodesk product either on startup or while you are
running the product. Click Getting Started ➤ Help ➤ About ➤ Product
Information.

When you activate your product, you receive an activation code. If you activate
through an Internet connection, your activation code is automatically retrieved
from Autodesk and the product starts. If you do not have an active Internet
connection, some products provide instructions for offline registration.
Otherwise, you need to connect to the Internet to activate the product.
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If you upgrade your product from an earlier version, you may need to provide
your old serial number. For more information on activation, go to Autodesk
Licensing and select the FAQ link.

NOTE If you are installing and using an Autodesk product on both operating
systems of a dual-boot operating system, you must obtain a separate activation
code for each operating system.

Registration
Depending on your product, registration is optional or required. If required,
you are prompted to create an Autodesk User ID associated with an individual
or company account. If registration is optional, you can choose to postpone
it, and you will be reminded periodically to register. The Autodesk website
where you register products is https://registeronce.autodesk.com.

Stand-Alone Licensing

A stand-alone license allows you to run an Autodesk® product on a single
workstation.

Introduction

A stand-alone license authorizes a single user to use the specified Autodesk
product. The product can be installed on more than one computer, but
multiple instances of the same product cannot be running concurrently on
different computers.

NOTE

The licensing and activation of both  SketchBook Designer and the add-in
SketchBook Designer for AutoCAD on a single Windows workstation are
shared. Activating one will automatically activate the other. Also, their trial
periods are linked, so that a trial for one will start the trial for the other, even
if not yet installed.

Stand-alone licensing allows you to use your Autodesk product in trial mode
for a specified period, usually 30 days, from the first time you start the product.
For a product suite, the trial period countdown begins when the first product
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is started, and it applies to all Autodesk products in the suite. You can activate
your license at any time before or after the trial period expires.

The licensing process creates a license file and a minor change to the
computer's file system. These changes remain on your computer when you
uninstall your product. If you reinstall your Autodesk product on the same
computer, the license remains valid. You do not have to reactivate the product.

Manage Your Stand-Alone License

This section provides information about advanced stand-alone licensing tasks
such as license types and behaviors, viewing product information, saving your
license file as a text file, updating your serial number, and transferring a license.

View Product License Information

You can view detailed information about your Autodesk product license, such
as the license usage type and the license behavior.

To view product license information

1 Start your Autodesk product.

2 Click Getting Started ➤ Help ➤ About ➤ Product Information.

Save License Information as a Text File

You can view detailed information about your Autodesk product and your
product license (such as the license usage type and the license behavior), and
then save this information as a text file for future reference.

To save license information as a text file

1 Start your Autodesk product.

2 Click Getting Started ➤ Help ➤ About ➤ Product Information.

3 In the Product License Information dialog box, click Save As.

4 In the Save As dialog box, name the file, choose a location where you
want to save the file, and then click Save.

5 In the Product License Information dialog box, click Close.
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Update Your Serial Number

You typically update your serial number for a stand-alone license when you
purchase a new license in order to change the license type or behavior. For
example, you would do this if you want to convert an educational license to
a commercial license, or if you want to extend the term of a term extendable
license. When you update a license, you do not need to uninstall and reinstall
the product. The new license includes a new serial number that you enter into
the Product License Information field.

Your serial number is located on the outside of the product packaging or in
the Autodesk Upgrade and Licensing Information email you received when you
downloaded your product.

When you register and activate your product, your serial number is submitted
to Autodesk over the Internet, if a connection is available.

If you have a suite of products that use a single serial number, only the first
product you register and activate displays the updated serial number. For other
products to display the serial number, you must update them from the Help
menu.

To update your serial number

1 Start your Autodesk product.

2 Click Getting Started ➤ Help ➤ About ➤ Product Information.

3 In the Product License Information dialog box, click Update.

4 In the Update the Serial Number dialog box, enter your product serial
number.

NOTE If you have lost your serial number, go to www.autodesk.com/contactus
for assistance.

5 Click OK. The updated serial number is displayed.

NOTE In some cases, you must restart the product to display the updated
serial number.

6 In the Product License Information dialog box, click Close.
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Transfer Your Stand-Alone License

You can use an Autodesk product on more than one computer without
purchasing a separate license for each computer. License transfers are only
supported for products that require the creation of an Autodesk ID as part of
the registration and activation process.

About the License Transfer Utility

The License Transfer Utility is used only with stand-alone licenses. It transfers
a product license online from one computer to another, and ensures that the
product works only on the computer that contains the license. A single license
applies to all products in a product suite. When you transfer the license, any
installed products of the suite are disabled on the exporting computer, and
enabled on the importing computer.

For Windows-based products, you can install the License Transfer Utility from
the Install Tools & Utilities tab of the installer.

IMPORTANT To transfer a license, the Autodesk product must be installed on
both computers. In addition, you need an Internet connection, and an Autodesk
user ID and password, available from the Autodesk Register Once
website(https://registeronce.autodesk.com).

IMPORTANT If you are using Autodesk products on Mac OS X or Linux platforms,
see your product appendix for more information on how to install and start the
License Transfer Utility. After the utility is started, the procedures for exporting
and importing licenses are the same on all platforms.

The License Transfer Utility is a custom stand-alone installation option. During
installation, a shortcut is created. A shortcut is installed once per product, per
computer.

You can transfer a license to another computer temporarily or permanently.
For example, a temporary transfer enables you to use the Autodesk product
on a mobile computer while your main computer is being repaired or replaced.

License transfers rely on the product serial number. Before an Autodesk license
can be exported, it must be activated with the serial number and product key.
During license import, a previously activated and exported license is imported
to a product or suite installed with the same serial number. The activation is
transferred to the importing computer, completing the license transfer.
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The number of concurrent license exports allowed is equal to the number of
seats you own. For example, if you own five seats you can have one export in
progress at a time.

When you upgrade your Autodesk product, you can no longer perform online
license transfers of the previous license.

Although the License Transfer Utility allows you to transfer your product
license between computers, your license agreement may not allow the
installation of an Autodesk product on more than one computer. Read your
license agreement to find out whether your product license permits the use
of the License Transfer Utility.

Install the Autodesk Product

Before you can use the License Transfer utility to transfer licenses, you must
have an Autodesk product installed on all computers involved in the transfer.

To install the Autodesk product

1 Install and activate the Autodesk product on a computer. See the
following for complete details:

Installing SketchBook Designer for Windows (page 3)

2 Install the Autodesk product on any other computer that will be using
the License Transfer Utility. You do not have to register or activate the
product on this computer.

See your product's installation instructions for complete details.

Export a License

A license is exported when the License Transfer Utility moves a product license
from a computer to the online Autodesk server.

The license can be exported as public or private:
■ Public means that anyone using the same serial number and their own

user ID and password can import that license.

■ Private means that you are reserving that license for yourself and the
license can only be imported with the same serial number, user ID, and
password that were used when it was exported.
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If it has not been imported, a private license becomes public after 14 days.

NOTE

An Internet connection is required to export a license.

To export a license

1 On the computer where you want to export the license, do one of the
following:
■ (Windows XP) Click Start  ➤  Programs  ➤  Autodesk  ➤  [Autodesk

Product] ➤  License Transfer Utility.

■ (Windows Vista) Click Start  ➤  All Programs  ➤  Autodesk
 ➤ [Autodesk Product] ➤  License Transfer Utility.

The Export the License dialog box displays the Autodesk product name
and serial number.

2 Click Sign In.

3 On the Log In page, enter your Autodesk user ID and password and click
Log In.

4 On the License Export page, confirm the export information.

5 If you want to make the license available as a public import, click Make
the license available as a public import.

6 Click Export.

7 On the License Export Confirmation page, click Finish.

Import a License

NO LABEL A license is imported when the License Transfer Utility moves a
previously exported product license from the online Autodesk server to a
computer. The import action completes the license transfer process, and
transfers the product activation to the importing computer. The presence of
an active license allows your Autodesk product to run on that computer.

NOTE

An Internet connection is required to import a license.
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To import a license

1 On the computer where you want to import the license, do one of the
following:
■ (Windows XP) Click Start  ➤  Programs  ➤  Autodesk  ➤  [Autodesk

Product]  ➤  License Transfer Utility.

■ (Windows Vista) Click Start  ➤  All Programs  ➤  Autodesk
 ➤ [Autodesk Product] ➤  License Transfer Utility.

The Import the License dialog box displays the Autodesk product name
and serial number.

NOTE  If you are importing a license to replace a trial license, you will see
the Update the Serial Number and Product Key dialog box. In this case, enter
the required data, and then click Update.

2 In the Import the License dialog box, click Sign In.

3 On the Log In page, enter your Autodesk user ID and password and click
Log In.

4 On the License Import Confirmation page, click Finish.

The license is now imported to the computer and you can run your
Autodesk product on this computer. If you want to transfer the license
to another computer, repeat the export and import procedures.

To import a license to replace a trial license

1 On the computer where you want to import the license, do one of the
following:
■ (Windows XP) Click Start  ➤  Programs  ➤  Autodesk  ➤  [Autodesk

Product] ➤  License Transfer Utility.

■ (Windows Vista) Click Start  ➤  All Programs  ➤  Autodesk  ➤ 

[Autodesk Product] ➤  License Transfer Utility.

The Update the Serial Number and Product Key dialog box displays the
Autodesk product name and serial number.

2 In the Update the Serial Number and Product Key dialog box, enter the
serial number and product key to update your Autodesk product. Click
Update.

The Import the License dialog box displays the Autodesk product name
and updated serial number.

3 In the Import the License dialog box, click Sign In.
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4 On the Log In page, enter your Autodesk user ID and password and click
Log In.

5 On the License Import Confirmation page, click Finish.

The license is now imported to the computer and you can run your
Autodesk product on this computer. If you want to transfer the license
to another computer, repeat the export and import procedures.

Troubleshoot a Stand-Alone License Error

When you activate your Autodesk product, only the computer that you used
to activate the product is licensed to run the product. If you make certain
changes to your computer, your stand-alone license might fail. You will receive
a license error and you will not be able to use your product. This section
discusses ways in which you can troubleshoot a license error.

Some license errors require you to reactivate your product. If you need to
reactivate your product, the Product Activation wizard is displayed when you
try to run the product. To reactivate your product, follow the instructions in
the Product Activation wizard.

The following topics offer more details regarding specific errors.

Preserving a License When Hardware Changes

If you replace or reconfigure hardware on the computer where your Autodesk
product license resides, the stand-alone license might fail, with the result that
you will not be able to use your product.

To prevent damage to your product license, use the License Transfer Utility
to export your license file before changing the hardware. After the hardware
change, you can import the license file back. For information about using the
License Transfer Utility, see About the License Transfer Utility (page 22).

NOTE If you get a license error when you change your hardware, you may have
to reactivate your license. See Activation (page 18).
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Reinstalling an Operating System

If you reinstall your operating system on the computer where your Autodesk
license resides, the license might fail. You will not be able to use your product.
To resolve a license error in this case, you must reactivate your product. See
Activation (page 18).

NOTE The following procedure is for the Windows operating system. If you are
running Autodesk products on Mac OS X or Linux platforms, see your product
appendix for more information.

To prevent a license error when you reinstall an operating system

NOTE If using Norton Ghost  or another image utility, do not include the Master
Boot Record.

1 Locate one of the following folders and make a backup copy:
■ (Windows XP) C:\Documents And Settings\All Users\Application

Data\FLEXnet

■ (Windows 7/Windows Vista) C:\ProgramData\FLEXnet

2 Reinstall the operating system and reinstall the Autodesk product.

3 Paste the license folder to the same location from which you originally
copied the folder in step 1.

You can now run your Autodesk product.

Changing the System Date and Time

Your product license allows for time changes to the system clock within two
days of the current time. If you set your system clock back more than two
days, the next time you start your product, you will receive a message that
gives you the option of correcting the system clock. If you do not correct the
system clock, you receive a license error.

To prevent a license error due to a change in system date and time, ensure
that your computer's system date and time are accurate when you install and
activate your Autodesk product.
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Preserving a License on a Re-imaged Computer

On a network license server, licenses are maintained on the server. No
additional steps are needed to preserve network licenses.

For a stand-alone license, you need to export the license before re-imaging
the computer. You can use the License Transfer Utility to export the license
to the Autodesk server. After the re-imaging, import the license to the correct
computer.

Network Licensing
A network license allows you to run an Autodesk product on a network.
Network licenses can be purchased through your Authorized Autodesk Reseller.

Setting up network licenses for an Autodesk product requires careful planning
and execution. This section gives you instructions about how to set up a
network licensed environment, and assumes that you are familiar with the
terminology and processes required to set up an Autodesk product to run on
a network.

Plan Your Network Licensing

This section contains information that you need to know before you set up a
network license server. The section includes information about supported
license server models, license operation and availability, network license file
definitions and parameters, license file examples, license types and behaviors,
and the license server heartbeat signal.

System Requirements for the Network License
Manager (Windows)

Make sure that your network license server meets the minimum recommended
requirements. See the following tables for hardware and software requirements.
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NOTE

The Network License Manager supports Ethernet network configurations only.

Hardware and software requirements for the network license server (Windows)

RequirementHardware/Software

Windows® 7® 32-bitOperating System

Windows 7 64-bit

■ Windows 7 Starter (32-bit)

■ Windows 7 Home Basic (32-bit)

■ Windows 7 Home Premium

■ Windows 7 Professional

■ Windows 7 Ultimate

■ Windows 7 Enterprise

Windows Vista 32-bit SP2 or later
Windows Vista 64-bit SP2 or later

■ Windows Vista Enterprise

■ Windows Vista Business

■ Windows Vista Ultimate

■ Windows Vista Home Premium and Basic (32-bit)

■ Windows Vista Home Premium (64-bit)

Windows XP 32-bit SP2 or later
Windows XP 64-bit SP2 or later

■ Windows XP Home

■ Windows XP Professional

Windows Server 32-bit SP1 or later
Windows Server 64-bit SP1 or later

■ Windows 2008 Server R2

■ Windows 2008 Server

■ Windows 2003 Server R2
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Hardware and software requirements for the network license server (Windows)

RequirementHardware/Software

■ Windows 2003 Server

Intel® Pentium® III or higherComputer/processor

450 Mhz (minimum)

Compatible with existing Ethernet network infrastructureNetwork interface card

NOTE

The Network License Manager supports multiple network interface cards,
but at least one must be an Ethernet card.

TCP/IPCommunication protocol

NOTE

The Network License Manager uses TCP packet types.

Internet Explorer® 6Browsers

Internet Explorer 7
Internet Explorer 8

11.7.0.0FLEXnet

Virtual Machine Support (Windows)

Virtual OSVirtualizerHardware

Vista 64-bit, Vista 32-bit, Windows XP
32-bit, Windows 7 32-bit (Home

Windows 2008 or Windows
2003R2 servers running on VM-

Intel PC 64

Premium, Professional, Ultimate, andware® ESX3.5 Update 3 (License
Manager Only) Enterprise), Windows 7 64-bit, Win-

dows Server 32-bit, Windows Server
64-bit
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System Requirements for the Network License
Manager (Linux)

Make sure that your network license server meets the minimum recommended
requirements. See the following tables for hardware and software requirements.

NOTE

The Network License Manager supports Ethernet network configurations only.

Hardware and software requirements for the network license server (Linux)

RequirementHardware/Software

Red Hat® Enterprise Linux 5.0 WS (U4)Operating system

Intel Pentium 3 or higherComputer/processor
450 Mhz (minimum)

Compatible with existing Ethernet network infrastructureNetwork interface card

NOTE

The Network License Manager supports multiple network interface cards,
but at least one must be an Ethernet card.

TCP/IPCommunication protocol

NOTE

The Network License Manager uses TCP packet types

11.7.0.0FLEXnet
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Plan Your License Server Configuration

You must decide which license server model to use for managing your Autodesk
product licenses on a server. Autodesk supports the following network license
server models:
■ Single license server model

■ Distributed license server model

■ Redundant license server model

Single License Server Model

In the single license server model, the Network License Manager is installed
on a single server, so license management and activity is restricted to this
server. A single license file represents the total number of licenses available
on the server.

Advantages of the Single License Server Model
■ Because all license management takes place on a single server, you have

just one point of administration and one point of failure.

■ Of the three license server models, this configuration requires the least
amount of maintenance.

Disadvantage of the Single License Server Model
■ If the single license server fails, the Autodesk product cannot run until the

server is back online.

Distributed License Server Model

In the distributed license server model, licenses are distributed across more
than one server. A unique license file is required for each server. To create a
distributed license server, you must run the Network License Manager on each
server that is part of the distributed server pool.

Advantages of the Distributed License Server Model
■ Servers can be distributed across a wide area network (WAN); they do not

need to exist on the same subnet.

■ If one server in the distributed server pool fails, the licenses on the
remaining servers are still available.
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■ If you need to replace a server in the distributed server pool, you do not
need to rebuild the entire pool.

■ Server replacement is easier than in a redundant server pool, where you
must reactivate the entire pool.

Disadvantage of the Distributed License Server Model
■ If a server in the distributed server pool fails, the licenses on that server

are unavailable.

Redundant License Server Model

In the redundant license server model, you use three servers to authenticate
a single license file. One server acts as the master, while the other two provide
backup if the master server fails. With this configuration, licenses continue
to be monitored and issued as long as at least two servers are still functional.
The license file on all three servers is the same. You must install the Network
License Manager on each server.

In the redundant license server model, all servers must reside on the same
subnet and have consistent network communications. (Slow, erratic, or dial-up
connections are not supported.)

Advantage of the Redundant License Server Model
■ If one of the three servers fails, all licenses that are managed in the server

pool are still available.

Disadvantages of the Redundant License Server Model
■ If more than one server fails, no licenses are available.

■ All three servers must reside on the same subnet and have reliable network
communications. The redundant server pool does not provide network
fault tolerance.

■ If one of the three servers is replaced, the complete redundant server pool
must be rebuilt.

■ If your Autodesk product supports license borrowing and licenses are
borrowed from a redundant license server pool, you must restart the license
server after you stop the Network License Manager.
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Learn About Your License

In this section, you learn about license operation and availability, the license
file, license types and behaviors, and the heartbeat signal.

License Operation and Availability

When you start an Autodesk product, the product determines the server from
which it should try to obtain a license. The product then requests a license
through the TCP/IP network protocol to the license server.

If the number of available licenses has not been exceeded on the license server,
the Network License Manager assigns a license to the workstation. A product
session then starts on the workstation, and the number of available licenses
on the license server is reduced by one.

Likewise, when you exit a product, the Network License Manager frees a license
for another user. If you run multiple sessions of an Autodesk product on an
individual workstation, only one license is used. When the last session is
closed, the license is freed.

The following three processes manage the distribution and availability of
licenses:
■ License manager daemon (lmgrd.exe). Handles the original contact

with the application, and then passes the connection to the vendor
daemon. The lmgrd.exe daemon is used to communicate with the vendor
daemon only; lmgrd.exe does not authenticate or dispense licenses, but
rather passes user requests to the vendor daemon. By using this approach,
a single lmgrd.exe daemon can be used by multiple software vendors to
provide license authentication. The lmgrd.exe daemon starts and restarts
the vendor daemons as needed.

■ Autodesk vendor daemon (adskflex.exe). Tracks the licenses that are
checked out and the workstations that are using them. Each software
vendor has a unique vendor daemon to manage vendor-specific licensing.
As its name implies, the adskflex.exe vendor daemon is specific to Autodesk
products.

NOTE If the adskflex.exe vendor daemon terminates for any reason, all users lose
their licenses until lmgrd.exe restarts the vendor daemon or the problem causing
the termination is resolved.

■ License file. A text file that has vendor-specific license information.
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License Files

The network license file you receive from Autodesk contains licensing
information required for a network installation. You obtain license file data
when you register your Autodesk product.

The license file contains information about network server nodes and vendor
daemons. It also contains an encrypted digital signature that is created when
Autodesk generates the file.

The license file is located in a network location that you specify. That network
location must be accessible to every user who runs the product from a network
installation.

The following table defines each license file parameter.

Definitions of license file parameters

ExampleDefinitionParameterLine

LABSERVERHost name of the server where the
Network License Manager resides

Host NameSERVER

03D054C0149BEthernet address of the server where
the Network License Manager resides

Host ID

[None]USE_SERVER

adskflex.exeName of the server-side Autodesk
vendor daemon

Vendor DaemonVENDOR

port=2080Network port number reserved and
assigned for use only by Autodesk

Port Number

products running the Autodesk
vendor daemon

SERIES_1Name of feature code groupNamePACKAGE

1.000Internal version number referenceVersion
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Definitions of license file parameters

ExampleDefinitionParameterLine

COMPONENTS=
"526000REVIT_9_OF\

List of feature codes supported in the
package

COMPONENTS

51200ACD_2007_OF\
513001INVBUN_11_OF"

OPTIONS=SUITEOPTIONS

SUPERSEDEReplacement for any existing Incre-
ment line of the same feature code

SUPERSEDE

from any license files on the same li-
cense server that have a date earlier
than the defined Issue Date

SIGN=0 SIGN2=0Encrypted signature used to authen-
ticate the attributes of the license file

SIGN

51200ACD_2007_0FProduct supported by the license fileFeature CodeINCREMENT

permanentAmount of time the licenses are
available

Expiration Date

25Number of licenses supported by the
license file

Number of Licenses

COMMERCIALLicense usage type and license beha-
vior of the product that is supported
by the license file

VENDOR_STRING

BORROW=4320Definition of the license borrowing
period for the licenses defined under
the same increment line.

BORROW

In this example, the maximum period
that licenses can be borrowed is 4320
hours (180 days), unless otherwise
noted (for example, BORROW=2880

36 | Chapter 3   Licensing SketchBook Designer



Definitions of license file parameters

ExampleDefinitionParameterLine

means that licenses can be borrowed
for a maximum of 2880 hours, or
120 days).
License borrowing is disabled when
this parameter is absent in the license
file.

DUP_GROUP=UHDefinition of multiple license requests
when the same user and same host
share the same license

DUP_GROUP

15-jul-2006Date that the license file was gener-
ated by Autodesk

ISSUED

123-12345678Serial number of the Autodesk
product

Serial Number

SIGN=6E88EFA8D44CEncrypted signature used to authen-
ticate the attributes of the license file

SIGN

License File Examples

License file examples are provided in this document to help you understand
how the license files work for your particular network setup. Autodesk provides
a standard license file for individual products and a license file with additional
parameters for products that are sold both individually and as part of a product
set.
■ Standard License File. If you purchase one or more individual products

that are not offered as part of a suite of products, you receive a standard
license file.

■ Standard License File with Additional Parameters. If you purchase
Autodesk products that are included in a product set and are also sold as
an individual product, you receive a standard license file with additional
parameters included in the license file. The additional parameters define
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the sequence for license usage so that the individual product license is
used before the license for the product set.

Autodesk license file examples include a license file not specific to a product,
completed license files for single, distributed, and redundant server models,
a combined product version license file, and an example of additional
parameters added to a standard license file.

Example of a License File Not Specific to a Product

Here is an example of the contents of a license file and the parameters
associated with each line:

SERVER ServerName HostID
USE_SERVER
VENDOR adskflex port=portnumber
INCREMENT feature_code Adskflex Version ExpDate
NumberofLicenses \

VENDOR_STRING=UsageType:Behavior BORROW=4320 SUPERSEDE \
DUP_GROUP=DupGrp ISSUED=IssueDate SN=SerialNumber SIGN=
\

Example of a License File for a Single or
Distributed Server

Here is an example of a completed license file for a single or distributed license
server model:

SERVER XXHP0528 0019bbd68993
USE_SERVER
VENDOR adskflex port=2080
INCREMENT 57600ACD_2009_0F adskflex 1.000 permanent 5 \

VENDOR_STRING=commercial:permanent BORROW=4320 SUPERSEDE
\
DUP_GROUP=UH ISSUED=09-Jan-2008 SN=123-12345678

SIGN="1393 \
E368 816E D417 C1CD 7DBD 7B90 1354 D6F0 48FE EBB8 9C84
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C3AF \
7D79 BEE1 0181 0655 76FF 996C B707 14B5 D4DE A3FE 0B2D

2D36 \
057C A579 7866 26BF 44E2" SIGN2="1280 943B 53A7 9B93

E00B D967 \
D821 BD37 BE6D B78A F074 B223 88AA 242C DD0A 1292 D56F

4108 \
62CD FA35 E365 0736 A011 7833 8B35 7BFF DAD8 34A8 452F

2EB4"

Example of a License File for a Redundant Server

Here is an example of a completed license file for a redundant license server
model:

SERVER CCN12378042 001cc4874b03 27005
SERVER XXHP0528 0019bbd68993 27005
SERVER CCN12378043 001cc4874b10 27005
USE_SERVER
VENDOR adskflex port=2080
INCREMENT 57600ACD_2009_0F adskflex 1.000 permanent 5 \

VENDOR_STRING=commercial:permanent BORROW=4320 SUPERSEDE
\
DUP_GROUP=UH ISSUED=10-Jan-2008 SN=123-12345678

SIGN="11C4 \
CA79 07FC 7AD0 409A 6E04 6E98 D76C 197C 0416 076C B211

1CDD \
D0AB 698B 16BF 7A0E D4F8 1CFE 2985 644F 64CD CECE 0DDB

5951 \
3262 7C31 13A8 F08F 55B2" SIGN2="19A6 FDA3 2ED5 5301

8675 7B81 \
1B0E 451B 19F1 1A99 C8E9 CBA6 8CB3 6AC3 8B38 1519 13F2

2373 \
82AE 55E5 1A25 4952 4458 F3A2 6F28 D25D 1DC0 E066 209B

0953"

NOTE

The redundant server model requires the addition of a port number (the default
is 27005) for each server.
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Example of a License File for Combined Autodesk
Product Versions

You can combine a license file for different releases of the same Autodesk
product or for different Autodesk products, and run all products from one
license server. For example, you can combine a license file for Autodesk Alias
2011 with license files for Autodesk Maya  2010 and AutoCAD 2009.

Here is an example of the contents of a combined license file for AutoCAD 2008
and AutoCAD 2009:

SERVER XXHP0528 0019bbd68993
USE_SERVER
VENDOR adskflex port=2080
INCREMENT 57600ACD_2009_0F adskflex 1.000 permanent 5 \

VENDOR_STRING=commercial:permanent BORROW=4320 SUPERSEDE
\
DUP_GROUP=UH ISSUED=09-Jan-2008 SN=123-12345678

SIGN="1393 \
E368 816E D417 C1CD 7DBD 7B90 1354 D6F0 48FE EBB8 9C84

C3AF \
7D79 BEE1 0181 0655 76FF 996C B707 14B5 D4DE A3FE 0B2D

2D36 \
057C A579 7866 26BF 44E2" SIGN2="1280 943B 53A7 9B93

E00B D967 \
D821 BD37 BE6D B78A F074 B223 88AA 242C DD0A 1292 D56F

4108 \
62CD FA35 E365 0736 A011 7833 8B35 7BFF DAD8 34A8 452F

2EB4"
INCREMENT 54600ACD_2008_0F adskflex 1.000 permanent 3 \

VENDOR_STRING=commercial:permanent BORROW=4320 SUPERSEDE
\
DUP_GROUP=UH ISSUED=09-Jan-2008 SN=123-12345678

SIGN="1E6E \
4B61 5712 4766 92A0 6782 9EF4 3F47 56A1 1F38 6DE8 C0C7

90AC \
7289 152E 0EA2 CC0D 3F10 577A 0489 CEB6 10D5 FBCC B552

0C9D \
5966 91A6 59F0 2788 FACE" SIGN2="1DDF 3B9D 3392 71D5

AB08 7E05 \
8497 111E 092F 0E54 8DC2 2BED 17C2 2CC1 981B 0EC2 BC15

8F00 \
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C79A ABFD 2136 BABA 2EDF E941 EA53 32C6 597F F805 5A8A
599A"

Example of Additional Parameters in a License
File

For Autodesk products that are included in a product set and are also sold as
an individual product, licenses are allocated based on a sequence of priorities
defined in the license file. For those products, information similar to the
following example appears in a license file:

SERVER Server1 1a34567c90d2
USE_SERVER
VENDOR adskflex port=2080
INCREMENT 54600ACD_2008_0F adskflex 1.000 permanent 5 \

VENDOR_STRING=commercial:permanent BORROW=4320 SUPERSEDE
\
DUP_GROUP=UH ISSUED=09-Jan-2007 SN=123-12345678

SIGN="0247 \
45D6 87C4 27A5 7F9E F24A ED3D 61E4 6B3B CC5C AD77 B865

9EA8 \
3D62 0792 0F67 19E7 57E7 FAFA A48B D582 335A EC16 1FE5

B70D \
76AB 6488 61CC DE5E F5B7" SIGN2="09FD 0850 7CF1 F447

9F05 9FA3 \
2A0A 38D6 83FC 1746 F3F5 5A72 6250 E002 DE0B 0E6E F88C

AC95 \
136F 87F2 A945 E4C4 A97F 44B5 74EE 83F3 3F3E 1579 B981

8994"

Package License File Examples

Autodesk offers a package license file option, which allows you use of a set of
products that are packaged and sold together. The package license file contains
a set number of licenses for four different versions of your software. Running
an instance of any one of the versions uses one license in the package. Packaged
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license files support prior versioning for subscription users. Package license
files operate under the following guidelines:
■ Package license files come with the current version of the software and

three previous versions of the same product.

■ License files may be combined with license files for different products. For
more information about combining license files, see Example of a Package
License File for Combined Autodesk Product Versions (page 44).

■ Package license files cannot be combined with non-package license files
for product versions contained in the package. For example, you cannot
combine a Autodesk Product 2009 package license file with a regular license
file for Autodesk Product 2008, 2007, or 2006.

■ Both the PACKAGE and INCREMENT sections of the license are required
for licensing to work properly. When you combine license files, be sure to
include both of these sections.

■ License borrowing, option files, and licensing cascading work the same
for package licenses as they do for regular license files.

■ A new license file will supersede an older license file.

The following sections provide package license file examples for single,
distributed, and redundant license servers, and combined Autodesk product
versions.

Example of a Package License File for a Single or
Distributed Server

Here is an example of a completed license file for a single or distributed license
server model:

SERVER Server1 1a34567c90d2
USE_SERVER
VENDOR adskflex port=2080
PACKAGE SERIES_1 adskflex 1.000
COMPONENTS="54700REVIT_2009_0F \

54600ACD_2009_0F 51300INVBUN_11_0F" OPTIONS=SUITE
SUPERSEDE \

ISSUED=09-Jan-2008 SIGN="1707 9EAC CBCB 2405 692E 4A89
\
AA26 30CC 2AC2 D6B3 A61B AB5E 492E 3EBD 0B48 4E75 193A

DA82" \
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FC45 C009 E360 944A 14BA E99C 9B24 5A1B 4A44 083A BE5F
3827 \
SIGN2="004A FC90 AB47 3F6B 59BC 0E6D 6681 6971 A76A BA52

98E2 \
5671 26B3 0E78 791B 109F 0591 7DC3 F09F 4D8D 4FB7 E341

4A03 \
CD68 1D77 27F8 8555 9CF7 DEDD 9380"

INCREMENT SERIES_1 adskflex 1.000 permanent 100 \
VENDOR_STRING=commercial:permanent BORROW=4320

DUP_GROUP=UH \
SUITE_DUP_GROUP=UHV SN=123-12345678 SIGN="1707 9EAC CBCB

\
692E 4A89 FC45 C009 E360 944A 14BA E99C 9B24 5A1B 4A44

BE5F \
3827 AA26 30CC 2AC2 D6B3 A61B AB5E 492E 3EBD 0B48 DA82"

\
SIGN2="004A FC90 AB47 3F6B 59BC 0E6D 6681 6971 A76A BA52

\
5671 26B3 0E78 791B 109F 0591 7DC3 F09F 4D8D 4FB7 E341

4A03 \
CD68 1D77 27F8 8555 9CF7 DEDD 9380"

Example of a Package License File for a Redundant
Server

Here is an example of a completed license file for a redundant license server
model:

SERVER 1a34567c90d2 27005
SERVER 2a34567c90d2 27005
SERVER 3a34567c90d2 27005
USE_SERVER
VENDOR adskflex port=2080
PACKAGE 64300ACD_F adskflex 1.000
COMPONENTS="57600ACD_2009_0F \

54600ACD_2008_0F 51200ACD_2007_0F 48800ACD_2006_0F" \
OPTIONS=SUITE SUPERSEDE ISSUED=27-May-2008 SIGN="1092

05D8 \
A206 276B 2C84 EFAD ACA5 C54B 68A4 653E C61F 31DE C8CE

B532 \
CFBB 0006 5388 347B FDD6 A3F4 B361 7FD4 CDE4 4AAC 0D11
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B0EF \
4B44 BFD6 3426 97DD" SIGN2="0670 B01A D060 0069 FF25

F1CD D06B \
314E E7C9 3552 5FFA 4AC7 28A7 C897 F56A 19BB FB1C 754E

6704 \
DEEA AC4E F859 2E9B 64B6 0DD0 9CCE 9556 269F EAC0 2326"

INCREMENT 64300ACD_F adskflex 1.000 permanent 50 \
VENDOR_STRING=commercial:permanent BORROW=4320 SUPERSEDE

\
DUP_GROUP=UH SUITE_DUP_GROUP=UHV ISSUED=27-May-2008 \
SN=399-99999999 SIGN="1B5B 8D70 4CAD 32E5 9CA2 82E0 5C47

291C \
35AB 9B9C 5B3E 5067 F61B 4139 1B32 0716 1FD3 5105 A991

B78E \
9D1E 63AB BC23 0D1E B70C 2A05 E1C1 F605 ABB1 2EA8"

SIGN2="01D6 \
31F5 2951 4500 E5C8 058F 7490 9789 9EF4 CBED DA27 5F06

6780 \
9033 2018 0C3B E1E0 3580 E60E C2BB B4AB 8D6A 4245 3059

8CA6 \
2EFE DFAE 027F 2ABE 3F2B"

Example of a Package License File for Combined
Autodesk Product Versions

Here is an example of a completed license file for combined Autodesk product
versions:

SERVER servername 123456789111
USE_SERVER
VENDOR adskflex port=2080
PACKAGE 64300ACD_F adskflex 1.000
COMPONENTS="57600ACD_2009_0F \

54600ACD_2008_0F 51200ACD_2007_0F 48800ACD_2006_0F" \
OPTIONS=SUITE SUPERSEDE ISSUED=25-Jun-2008 SIGN="03EF

DE18 \
8046 0124 4EA4 6953 F82D 3169 7C24 D0DE E58E 8168 FFA3

D891 \
B43B 08D8 7E7F C6ED CBCC FE2A BB0A 4566 C2AE F1C1 D373

8348 \
E6E3 884A E398 1C78" SIGN2="07AC D696 8844 D19F AB00
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8B75 53A3 \
2F76 91DF AED0 3231 1506 0E6B ADC6 C3B8 1797 93B5 9756

8C0F \
8811 56E6 B2BA 0523 FE2E 82B7 1628 076F 173B F37C 7240"

INCREMENT 64300ACD_F adskflex 1.000 permanent 2 \
VENDOR_STRING=commercial:permanent BORROW=4320 SUPERSEDE

\
DUP_GROUP=UH SUITE_DUP_GROUP=UHV ISSUED=25-Jun-2008 \
SN=399-99999999 SIGN="1CCB E88D B819 8604 06FA 9AEE 42F1

CBEA \
37B9 3CFA A0A8 697F 9CB1 8354 6256 05ED 69D4 D2FF D512

6A2E \
D5DD B722 EF5B 3172 BA95 4625 F8D3 DD24 BB39 6A58"

SIGN2="0DFF \
FA6F C378 20E0 2622 BE52 B434 F99F 2681 2B93 64F2 CE0C

7F4A \
7024 B3D1 051A 6920 72BD DE35 8920 E6A1 C8D6 AF23 7BE7

CC91 \
6916 70B1 9E80 AB07 1644"

PACKAGE 64800INVPRO_F adskflex 1.000 \
COMPONENTS="59600INVPRO_2009_0F \

55300INVPRO_2008_0F 51400INVPRO_11_0F 49000INVPRO_10_0F"
\
OPTIONS=SUITE SUPERSEDE ISSUED=25-Jun-2008 SIGN="1306

5990 \
F8A1 56FB 1D8A 9DA7 D6AE 8E9E F6EC 2862 367A 36E2 C5FB

E6E1 \
4AAA 0128 8C2D 95FD 09B2 ABA1 6F98 A0A3 70DE 3220 6835

7E51 \
3849 9D81 8BDC 9DC1" SIGN2="0021 AA08 F2E7 8AEB 5345

341A 7E42 \
3001 B8C5 DFC2 6EB8 87C5 C04A AE43 A10F 1DA1 EF8A F0FA

10F5 \
AC81 1E22 789F A18D 650F 6BBB 563A BDA5 DD1C 82EC 27F6"

INCREMENT 64800INVPRO_F adskflex 1.000 permanent 2 \
VENDOR_STRING=commercial:permanent BORROW=4320 SUPERSEDE

\
DUP_GROUP=UH SUITE_DUP_GROUP=UHV ISSUED=25-Jun-2008 \
SN=399-99999966 SIGN="0BE4 51F4 570C DC48 5E66 F952 629E

EDF0 \
019C 6FF7 0509 1FF0 D4FB 3B16 1981 073F 31EC A241 8CB3

8782 \
E655 00C6 E097 D5EF B0D8 67D3 199D 699D 2E09 B16F"
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SIGN2="1254 \
3E37 0CE4 F42D B7CD 858C 92FC A963 5274 770F 9354 FE29

E117 \
205D C632 0C4E AEC0 7501 9D9E FFEB D84D F154 16A1 E120

339A \
FDBF 3F07 4477 B8B3 5DA4"

License Types and Behaviors

Autodesk supports dynamic product usage and license behaviors. This means
that you can purchase a specific type of behavior with a specific license and
change that license at a later date without having to uninstall and reinstall
the Autodesk product.

License types include the following:
■ Commercial. A license for a product that was purchased commercially.

■ Not for Resale. A license for a product that is not sold commercially.
Not for Resale products are for evaluation or demonstration purposes only
and may not be used for commercial or production use.

■ Educational (EDU)/Institution. A license designed specifically for
educational institutions.

■ Student Portfolio. A license for students who are using an Autodesk
product as part of their curriculum.

License behaviors are as follows:
■ Permanent. Enables permanent use of an Autodesk product.

■ Term Extendable. Enables access to an Autodesk product for a limited
time. The term can be extended at any time.

■ Term Non-Extendable. Enables an Autodesk product for a limited time.
The term cannot be extended.

Heartbeat Signal

When an Autodesk product is running, it communicates with the license
server at regular intervals using a communication method known as the
“heartbeat” signal. If the heartbeat signal is lost, the server tries to reconnect.
If the server cannot reconnect, the user receives a license error.
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If the product stops working because it has lost a connection to the server,
you must shut down the product, and then restart it. If the problem causing
the original loss of the heartbeat signal is resolved and there are available
licenses on the server, the program can be restarted.

Network License Manager

The Network License Manager is used to configure and manage the license
servers. The Installation wizard prompts you for information about the license
manager, such as license server model and server name.

Install the Network License Manager

You can install the Network License Manager before or after you use the
Installation wizard. The order in which you install the network applications
does not matter, as long as you install everything you need and you provide
consistent license server information across the network applications.

If an earlier version of the Network License Manager is already installed on
the computer, you should upgrade by installing the Autodesk Network License
Manager into the folder where the older version was located.

To install your Network License Manager

1 In the Autodesk Installation wizard, click Install Tools and Utilities.

2 On the Select the Products to Install page, select Autodesk Network
License Manager and click Next.

3 Review the Autodesk software license agreement for your country or
region. You must accept this agreement to proceed with the installation.
Choose your country or region, click I Accept, and then click Next.

NOTE

If you do not agree to the terms of the license and want to terminate
the installation, click Cancel.

4 On the Review - Configure - Install page, review your product selection
and the current settings. If you do not want to change anything, click
Install. If you want to change the install type or installation path, click
Configure.
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5 On the Select the Installation Type page, select Typical or Custom and
accept the default installation path (C:\Program Files\Autodesk Network
License Manager\) or Browse to specify a different path. If you enter a
path that does not exist, a new folder is created using the name and
location you provide. Click Next.

WARNING

Do not install the Network License Manager on a remote drive. When
you install the Network License Manager files, you must provide a path
to a local drive. You must specify the drive letter; the universal naming
convention (UNC) is not permitted.

6 On the Configuration Complete page, click Configuration Complete to
return to the confirmation page.

7 On the Review - Configure - Install page, click Install.

8 When the Installation Complete page displays, click Finish.

Obtain a License Through autodesk.com

You can register and activate your network license by going to
https://registeronce.autodesk.com and following the on-screen instructions.

Obtain the Server Host Name and Host ID
Manually

Autodesk uses the server host name, host ID, and product serial number to
generate a license file.

To obtain the information manually, you can use the command prompt or
you can run the lmtools.exe utility. If you use lmtools.exe, do not run it on a
remote workstation.

To obtain the host name and ID using the Windows command prompt

1 Do one of the following:
■ (Windows XP) Click Start  ➤  Programs  ➤  Accessories  ➤  Command

Prompt.

■ (Windows Vista) Click Start  ➤  All Programs  ➤  Accessories  ➤ 

Command Prompt.
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2 At the Windows command prompt, enter the following command, and
then press ENTER:

ipconfig /all

3 Record the Host Name and Physical Address line. Eliminate dashes from
the physical address. This is your twelve-character host ID.

NOTE If your server has more than one network adapter, select the one that
corresponds to a physical network adapter. To determine which adapters
are physical: in the Windows command prompt, enter ipconfig /all, and
then view the Description field above each physical address. If there is more
than one physical network adapter, it does not matter which one you use.
Devices such as VPN adapters, PPP adapters, and modems are not valid.

4 Close the Windows command prompt.

To obtain the host name and ID using lmtools.exe

IMPORTANT Do not run LMTOOLS on a remote computer.

You should be logged in with Administrator rights when working with the
LMTOOLS utility.

1 Do one of the following:
■ (Windows XP) Click Start  ➤  Programs  ➤  Autodesk  ➤  Network

License Manager  ➤  LMTOOLS.

■ (Windows Vista) Double-click the LMTOOLS icon on the desktop.

2 In the LMTOOLS program, click the Systems Settings tab.

3 Locate the Computer/Hostname box. Copy the host name and paste the
information into a text editor.

4 Locate the Ethernet Address box. The 12-character Ethernet address is
the host ID. Write down the information.

NOTE If your server has more than one Ethernet adapter, select one that
corresponds to a physical network adapter. If you are using a Mac OS X
computer with more than one network card, you must use the address of
the primary network card.

5 Close lmtools.exe.
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Configure a License Server (Windows)

You configure a license server so that you can manage your Autodesk product
licenses. Configure the license server with the lmtools.exe utility.

To configure your license server

You should be logged in with Administrator rights when working with the
LMTOOLS utility.

1 Do one of the following:
■ (Windows XP) Click Start  ➤  Programs  ➤  Autodesk  ➤  Network

License Manager  ➤  LMTOOLS.

■ (Windows Vista) Double-click the LMTOOLS icon on the desktop.

2 In the LMTOOLS program, on the Service/License File tab, make sure
the Configure Using Services option is active.

3 Click the Config Services tab.

4 In the Service Name list, select the service name you want to use to
manage licenses.

By default, the service name is Flexlm Service 1. If FLEXnet is managing
other software on your computer in addition to Autodesk, you can change
the service name to avoid confusion. For example, you can rename Flexlm
Service 1 to Autodesk Server1.

NOTE

If you have more than one software vendor using FLEXnet for license
management, the Service Name list contains more than one option.
Make sure that only one Autodesk service is listed.

5 In the Path to Lmgrd.exe File field, enter the path to the Network License
Manager daemon (lmgrd.exe), or click Browse to locate the file.

By default, this daemon is installed in the C:\Program Files\Autodesk
Network License Manager folder.

6 In the Path to the License File box, enter the path to your license file,
or click Browse to locate the file.

This is the path to the license file obtained through autodesk.com or the
location where you placed the license file if you obtained it offline.

7 In the Path to the Debug Log File box, enter a path to create a debug
log, or click Browse to locate an existing log file.
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It is recommended that you save to the C:\Program Files\Autodesk Network
License Manager folder. The log file must have a .log file extension. For
new log files, you must enter the .log extension manually.

8 To run lmgrd.exe as a service, select Use Services.

9 To start lmgrd.exe automatically when the system starts, select Start Server
at Power Up.

10 Click Save Service to save the new configuration under the service name
you selected in step 4. Click Yes when prompted if you would like to
save the settings to the service.

11 Click the Start/Stop/Reread tab and do one of the following:
■ If a service has not yet been defined for Autodesk, click Start Server

to start the license server.

■ If a service for Autodesk is already defined and running, click ReRead
License File to refresh the Network License Manager with any changes
made to the license file or Options file.

The license server starts running and is ready to respond to client
requests.

12 Close lmtools.exe.

NOTE Before performing any system maintenance on your license server,
see Stop and Restart the License Server (page 55).

Configure a License Server (Linux)

You configure a license server so that you can manage your Autodesk product
licenses.

To configure automatic start-up of your license server

Before configuring your license server for Linux, ensure that the following
steps have been completed:
■ You have installed the Autodesk Network License Manager which contains

the following files: lmgrd, adskflex, and lmutil.

■ You have received the network license file from Autodesk that contains
the product licenses; for example, productlicense.lic.

1 Extract the FLEXnet IPv4 server files into the following directory:
/home/<user id>/flexlm11.7.
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NOTE Replace <user id> with your user id, not a root user id.

2 Copy the .lic file into the flexlm11.7 directory created in Step 1.

3 Open a terminal window in root mode.

4 Go to the directory /etc/.

5 Locate the rc.local file.

6 Edit the rc.local file and start lmgrd by entering the following commands
in the terminal window:

NOTE Replace acad.lic with your license file name.

7
/bin/su <user id> -c ‘echo starting lmgrd>\
/home/<user id>/flexlm11.7/boot.log’

/usr/bin/nohup/bin/su <user id> -c ‘umask 022;\
/home/<user id>/flexlm11.7/lmgrd -c\
/home/<user id>/flexlm11.7/acad.lic >> \
/home/<user id>/flexlm11.7/boot.log ‘

/bin/su <user id> -c ‘echo sleep 5 >> \
/home/<user id>/flexlm11.7/boot.log ‘

/bin/sleep 5

/bin/su <user id> -c ‘echo lmdiag >>\
/home/<user id>/flexlm11.7/boot.log ‘

/bin/su <user id> -c ‘/home/<user id>/flexlm11.7/lmutil
lmdiag -n -c\
/home/<user id>/flexlm11.7/acad.lic >> \
/home/<user id>/flexlm11.7/boot.log ‘

/bin/su <user id> -c ‘echo exiting >>\
/home/<user id>/flexlm11.7/boot.log ‘

8 Save the edited rc.local file.
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9 Reboot your machine and verify that the lmgrd and adskflex have started
by doing one of the following:
■ During the reboot, look for the message that the license server has

started.

■ Check the boot.log file created in /home/<user id>/flexlm11.7/ to see if
lmgrd and adskflex have started.

NOTE Before performing any system maintenance on your license server, see Stop
and Restart the License Server (page 55).

Install SAMreport-Lite (Optional)

SAMreport-Lite is a reporting tool that helps you track network license usage.
With SAMreport-Lite technology from Flexera™ Software, you can monitor
client usage for Autodesk network licensed products.

To learn more about installing and using SAMreport-Lite, see the SAMreport-Lite
User’s Guide.

Uninstall the Network License Manager

You can uninstall the Network License Manager from the license server. When
you uninstall the Network License Manager, licenses are no longer available
to your users.

To uninstall the Network License Manager

1 Do one of the following:
■ (Windows XP) Click Start  ➤  Programs  ➤  Autodesk  ➤  Network

License Manager  ➤  LMTOOLS.

■ (Windows Vista) Double-click the LMTOOLS icon on the desktop.

2 In the LMTOOLS program, click the Start/Stop/Reread tab.

3 On the Start/Stop/Reread tab, click Stop Server.

4 Close lmtools.exe.

5 In the Windows Control Panel, double-click Add/Remove Programs.

6 In the Add/Remove Programs window, click Autodesk Network License
Manager. Click Remove.
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7 If prompted, restart your computer.

NOTE

You must manually delete files that you created for use with the Network
License Manager (such as log files, license files, and the Options file). They
are not automatically deleted when you uninstall the Network License
Manager.

Network Licensing Tools

Autodesk  Network licensing tools include FLEXnet configuration tools, license
borrowing, and SAMreport-Lite. Each tool is described in the sections that
follow.

This section also includes information for updating FLEXnet and installing
and configuring the Autodesk Network License Manager on a network.

FLEXnet Configuration Tools

The Network License Manager uses FLEXnet® license management technology
from Flexera Software™. FLEXnet provides administrative tools that help to
simplify management of network licenses. You can use FLEXnet tools to
monitor network license status, reset licenses lost to a system failure,
troubleshoot license servers, and update existing license files on the fly.

Utilities for License Server Management

FLEXnet provides two utilities for managing the license server. These tools
are located in the C:\Program Files\Autodesk Network License Manager folder.
LMTOOLS Utility (lmtools.exe) Provides a Microsoft  Windows graphical
user interface for managing the license server.

lmutil.exe Provides a set of command line options for managing the license
server.

You can use LMTOOLS or lmutil.exe to perform the following server
management tasks:
■ Start, stop, and restart the server.

54 | Chapter 3   Licensing SketchBook Designer



■ Configure, update, and reread the license file.

■ Diagnose system or license problems.

■ View server status, including active license status.

Stop and Restart the License Server

Before you can perform any system maintenance, including uninstalling the
Autodesk License Manager on your license server, you must stop the license
server. When you have completed maintenance, you can restart the license
server.

To stop the license server

You should be logged in with Administrator rights when working with the
LMTOOLS utility.

1 Click Start  ➤  All Programs  ➤  Autodesk  ➤  Network License Manager
 ➤  LMTOOLS Utility.

2 In the LMTOOLS utility, click the Service/License File tab.

3 Select the Configure Using Services option.

4 Select the service name for the license server you want to stop manually.

5 Click the Start/Stop/Reread tab.

6 Click Stop Server.

7 Close LMTOOLS.

To restart the license server

You should be logged in with Administrator rights when working with the
LMTOOLS utility.

1 Click Start  ➤  All Programs  ➤  Autodesk  ➤  Network License Manager
 ➤  LMTOOLS Utility.

2 In the LMTOOLS utility, click the Service/License File tab.

3 Select the Configure Using Services option.

4 Select the service name for the license server you want to start manually.

5 Click the Start/Stop/Reread tab.

6 Click Start Server to restart the license server.
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Update FLEXnet from a Previous Version

This release of Autodesk products require FLEXnet version 11.9.0.0 or later.
If you are currently using a version of FLEXnet that is earlier than 11.9.0.0,
you need to upgrade to version 11.9.0.0 or later.

NOTE If the server where you plan to install the Autodesk Network License
Manager has FLEXnet installed for another product, make sure that the version of
lmgrd.exe is the most current version.

To determine what version of FLEXnet is installed, you need to verify the
version of the following files:

Windows

■ lmgrd.exe

■ lmtools.exe

■ lmutil.exe

■ adskflex.exe

To verify the version of LMTOOLS Utility, lmutil.exe, or adskflex.exe

You should be logged in with Administrator rights when working with the
LMTOOLS utility.

1 Click Start  ➤  All Programs  ➤  Autodesk  ➤  Network License Manager
 ➤  LMTOOLS Utility.

2 In LMTOOLS utility, click the Utilities tab.

3 Enter the location of the file, or click the Browse button to locate the
file and click Open. The file location should look something like this:

C:\Program Files\Autodesk Network License Manager\lmutil.exe

4 Click Find Version.

The version number of the file you selected is displayed. If necessary,
use the following procedure to update your version of FLEXnet.
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To update FLEXnet

You should be logged in with Administrator rights when working with the
LMTOOLS utility.

1 Back up your license files.

2 Click Start  ➤  All Programs  ➤  Autodesk  ➤  Network License Manager
 ➤  LMTOOLS Utility.

3 In the LMTOOLS utility, click the Start/Stop/Reread tab.

4 Click Stop Server.

5 Close LMTOOLS.

6 Note the location where the Network License Manager is installed and
then uninstall the Network License Manager. For details about
uninstalling the Network License Manager, see Uninstall the Network
License Manager (page 53).

7 Install the Network License Manager. For details about installing the
Network License Manager to the same location as the previous version,
see Install the Network License Manager (page 47).

8 Do one of the following:
■ (Windows XP) Click Start  ➤  Programs  ➤  Autodesk  ➤  Network

License Manager  ➤  LMTOOLS.

■ (Windows 7/ Windows Vista) Double-click the LMTOOLS icon on
the desktop.

9 In the LMTOOLS utility, click the Start/Stop/Reread tab.

10 Click Start Server.

11 Close LMTOOLS.

Set Up and Use an Options File

With an Options file, you set configuration options for managing licenses on
each license server that you set up. An Options file sets parameters that the
license file reads and the lmgrd program executes.

If you want to have the same license behavior on some or all of your license
servers, you must save the same Options file to each of those license servers.
If you want to specify different license behavior on different license servers,
you must create an Options file for each license behavior. You must save each
Options file to the server where you want specific license behavior.
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NOTE For Options file changes to take effect on a license server, you must save
the Options file, and then use LMTOOLs utility to reread the license file.

Use the Options file to set parameters for the following server-related features:
Report log file A compressed, encrypted file is created that generates accurate
usage reports on license activity. See Create_a Report_Log.

License borrowing See Configure_License_Borrowing_with_the Options_File.

License timeout See Set_Up_License_Timeout.

License timeoutall See Set_Up_License_Timeout.

You can also set up advanced license parameters, such as reserving a license,
restricting license usage, or defining groups of users. To learn more about
setting advanced Options file parameters, see the FLEXnet documentation in
the C:\Program Files\Autodesk Network License Manager\LicenseAdministration.pdf
file.

License Borrowing

If you are running a network-licensed version of an Autodesk product, you
can borrow a license from a license server to use the Autodesk product for a
specified time when your computer is not connected to the network.

NOTE If you have a stand-alone version of an Autodesk product, you cannot
borrow a license. To check your license type, click Help drop-down list  ➤  About
 ➤  Product Information. In the Product License Information dialog box, view your
product license type.

Overview

If you are using a network-licensed version of your Autodesk product and your
network administrator supports the license borrowing feature, you can borrow
a product license from your network license server to use an Autodesk product
when your computer is not connected to the network. Your license is
automatically returned to the license server at the end of the day on the return
date you set when you borrowed the license. You can also return a license
early.
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NOTE There is a limit to the number of licenses available for borrowing. If you
try to borrow a license and are notified that no licenses are available, all network
licenses may already be borrowed by other users. If you are unable to borrow a
license, see your network administrator for help.

Borrow a License

You can run your Autodesk product when your computer is not connected
to the network until your license-borrowing period ends. If you don't remember
the date that a license expires, you can check the date by placing your cursor
over the Borrowing icon in your Autodesk product's status tray or by clicking
Help  ➤  About and using the Product License Information dialog box.

When the license-borrowing period expires, the borrowed license is
automatically returned to the license server. Once your computer is
reconnected to the network, you can run your Autodesk product from the
network or borrow a license again.

Interaction with Other License-Borrowing Tools

Using the license borrowing feature in your Autodesk product is the
recommended way to borrow a license; however, some third-party borrowing
tools may also be available to you. These tools are not supported or compatible
with the license borrowing feature in your Autodesk product. Other third-party
or legacy license-borrowing tools that may be available to you are the Autodesk
License Borrowing utility (shipped with Autodesk products) and the borrowing
feature in LMTOOLS utility, a component of the Autodesk Network License
Manager.

If another license-borrowing tool is active when you attempt to use the license
borrowing feature, you should proceed as follows to borrow a license for your
Autodesk product:
■ If you run the Autodesk License Borrowing utility that shipped with your

Autodesk product and then turn on the borrowing flag for the Adskflex
option or the All option, a license can be borrowed when you start your
Autodesk product. However, you cannot return a license until you exit
and then restart your Autodesk product.

■ If borrowing is set in LMTOOLS utility for all products, you can either (a)
use the other tool to borrow licenses for your Autodesk product or (b) stop
the borrowing process in LMTOOLS utility and then use the license
borrowing feature in your Autodesk product.

Network Licensing | 59



■ If borrowing is set in LMTOOLS utility for non-Autodesk products only,
you must stop the borrowing process in LMTOOLS utility. You can then
use the license borrowing feature to borrow licenses for your Autodesk
product. If you do not stop the borrowing process in LMTOOLS utility,
the license borrowing feature will not function.

To borrow a license using the Help menu

1 Click Help drop-down list  ➤  About.

2 In the About product window, click Product Information.

3 In the Product lIcense Information window, click Borrow License.

4 In the Borrow a License window, on the calendar, click the date when
you want to return the license.

This date must be within the valid date range set by your network
administrator. The valid date range is displayed in this window.

5 Click Borrow License.

6 In the License Borrowed message, click OK. The license is borrowed, and
you can now use the Autodesk product while your computer is
disconnected from the network.

BORROWLICENSE Command

Borrows a product license so that you can run the product outside the network
environment.

Help menu: About  ➤  Product Information  ➤  Borrow License

Command line: borrowlicense

The Borrow a License Window is displayed.

Return a License

Your network license is automatically returned to the network license server
on the day that the license expires. You can also return a license earlier than
the date you originally selected, as long as your computer is connected to the
network license server when you attempt to return the borrowed license.
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Once a borrowed license is returned, you can borrow a license again as long
as your computer is connected to the network license server and a license is
available on the server.

To return a borrowed license early, do one of the following:

■ Click Help menu  ➤  About  ➤  Product Information. In the Product License
Information dialog box, click Return License, and then click Yes.

■ In the status tray, right-click the License Borrowing icon. Click Return
License Early.

NOTE To use the status tray to return a borrowed license early, the display settings
for the status tray must be turned on. To turn on the display settings, right-click
an empty area on the status bar. Click Tray Settings.

Your license is returned to the network license server. After you return the
borrowed license, you can borrow a license again immediately as long as a
license for that product is available on the network.

To check the license return date, do one of the following:

■ In the status tray, right-click the License Borrowing icon. View the
expiration date for the borrowed license.

■ Click Help menu  ➤  About  ➤  Product Information. In the Product License
Information dialog box, under License Expiration Date, view the license
return date.

RETURNLICENSE Command

Returns a borrowed Autodesk product license earlier than the original return
date that you specified when you borrowed the license.

Help menu: About  ➤  Product Information  ➤  Return License

Status tray: Right-click the License Borrowing icon. Click Return License Early.

Command line: returnlicense
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Network Licensing FAQs

This section outlines some common questions and their solutions with regards
to software licenses and licensing your product(s).

What is the difference between a stand-alone
license and a network license?

What is the benefit of using a network licensed
version of the software?

Glossary
ADSKFLEX_LICENSE_FILE  In a distributed license server configuration,
the environment variable used to point a computer to the distributed license
servers.

adskflex or adskflex.exe The Autodesk vendor daemon used with the FLEXnet
license technology. This daemon keeps track of the Autodesk licenses that are
checked out and the computers that are using the licenses.

borrowed license A type of network license that allows you to use an Autodesk
product for a limited period of time disconnected from the network, without
having to buy a separate license.

daemon A program that runs continuously in the background of a computer.
The daemon handles requests from the computer and then forwards the
requests to other programs or processes. The Network License Manager uses
two daemons: the vendor daemon (adskflex or adskflex.exe) and the license
manager daemon (lmgrd or lmgrd.exe).

debug log file A file used with FLEXnet to log connection events between
the Network License Manager and the user's computer.

deployment A set of files and folders created on a server and used by
computers to install Autodesk programs with a consistent configuration.

distributed server A license server configuration option in which several
servers are used to manage license distribution. Each distributed license server
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has a unique license file and a fixed number of licenses. If one distributed
license server fails, the other servers are still able to distribute their licenses.

Ethernet address See host ID.

feature code A license file parameter that represents the product that is
supported by that license file.

FLEXnet The Flexera Software license management technology implemented
in the Autodesk family of products.

heartbeat signal The communication signal between the Network License
Manager and the computer to verify that the computer is accessible and has
an active Autodesk product session running.

host ID The unique hardware address of a network adapter. Also known as
Ethernet address or physical address.

host name The TCP/IP name associated with a computer. FLEXnet technology
uses the host name as a parameter; the host name must be distinguished from
the NetBIOS (server) name.

idle A state of inactivity in your product that prompts a network license server
to reclaim a license. Inactivity is due to no mouse or keyboard activity and
no commands, LISP expressions, menu macros, or scripts in progress for the
period of time that is defined in the options file. See also license timeout.

JRE (Java Runtime Environment) A program that is required to run Java
programs.

license file A file used with FLEXnet that controls the number of available
seats. This file must be in ASCII plain text format.

license server A server that contains the Network License Manager and
manages the distribution of licenses to users.

license timeout For network licenses, this is a time period that starts counting
when a computer that is using a license is idle. If the timeout period elapses
and the computer remains idle, the license is returned to the license server
and is available for use again.

licpath.lic In both single and redundant server configurations, the file used
to point the computer to the FLEXnet license server. Licpath.lic is located in
the root installation folder.

lmgrd or lmgrd.exe The license manager daemon. This daemon handles the
original contact with the program, and then passes the connection to the
vendor daemon, adskflex or adskflex.exe.
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lmtools or lmtools.exe A graphical user interface utility for administering the
FLEXnet license technology. See also lmutil or lmutil.exe.

lmutil or lmutil.exe A command-line utility used to administer the FLEXnet
license technology. See also lmtools or lmtools.exe

master daemon Seelmgrd or lmgrd.exe.

network license installation A type of Autodesk product installation that
requires the Network License Manager installed on one or more network
servers to manage the distribution of product licenses to users.

Network License Manager The technology used by Autodesk for network
license management.

options file The file used by FLEXnet to set network license management
parameters, such as the location of report logs and the time period for license
borrowing.

physical address See host ID.

redundant server A license server configuration option in which three servers
are used to administer licenses. The redundant servers share a license file and
a pool of licenses. The redundant server pool remains functional as long as
two of the three servers are running and communicating with each other.

report log file A file used with FLEXnet to provide information about network
license usage. The options file sets parameters for the report log.

vendor daemon See adskflex or adskflex.exe.
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Troubleshooting

Troubleshooting
Learn debugging techniques to resolve common problems when installing
SketchBook Designer software and licenses.

Online help and support information

This Installation Guide can be found at the top level of the software DVD, along
with the Readme and System Requirements. HTML help for SketchBook Designer
can be found in the Help menu.

CHM help for SketchBook Designer for AutoCAD can be found in the Help
menu.

Additional resources

■ For information about  SketchBook Designer issues, see the Autodesk Web
site: http://www.autodesk.com. Click the Services & Support tab and choose
the product Autodesk  SketchBook Designer from the drop-down list of
supported products. The Autodesk Support organization provides you with
prompt and professional technical support when you need it.

■ For information about various Windows issues, see the Web site
http://www.microsoft.com

■ For details on installation and performance issues, check the Web site of
your graphics card manufacturer.

■ Bookstores provide an array of helpful books on Windows for various types
of users and administrators.
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Licensing troubleshooting

SolutionQuestionBrief description

A.  Yes. If your computer gets its
SketchBook Designer license from a li-

Q.  Can I run two cop-
ies of  SketchBook De-

Run two copies of
SketchBook Designer

cense server, it uses only one licensesigner at the same time
on the same machine? even if you run multiple copies of

SketchBook Designer on the same ma-
chine. Note that on Mac OS, to run two
copies of  SketchBook Designer at the
same time, you must copy the applica-
tion file (.app) itself and then double-
click the copy.

A.  The Windows Task Manager lets you
kill a task that for some reason no longer

Q.  How do I kill the
SketchBook Designer

Kill  SketchBook De-
signer

responds to your commands. To displayprogram when I can’t
exit? the Task Manager, press the Ctrl

 + Shift  + Esc

 keys. On Mac OS, use Force Quit
Application to kill a task. To display
Force Quit Application, press the Com-

mand  + Option  + Q

+ Esc  keys. If possible, do not
quit  SketchBook Designer in this way,
because you are likely to lose some of
your work. Instead, click File > Exit.

A.  In  SketchBook Designer, click Help
> About  SketchBook Designer; or

Q.  How do I find out
which version of

Version info

on your Windows desktop, right-click
on the icon and choose Properties.

SketchBook Designer I
have?
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SolutionQuestionBrief description

A.  This depends on the speed of your
computer. In any case,  SketchBook

Q.  How long does it
take  SketchBook De-
signer to start?

Start time

Designer should start within ten
seconds.

A.  No. Refer to System requirements
for Windows (page 3)to determine

Q.  Can I run  Sketch-
Book Designer for

Operating Systems

which versions of Windows are qualified
to run  SketchBook Designer.

Windows on Windows
95, Windows 98, or
Windows 2000?

Installation Troubleshooting
This section provides solutions to installation issues and answers to commonly
asked questions that may arise while installing your product(s). Additional
troubleshooting information and support is also available at
http://autodesk.com/servicesandsupport

Frequently Asked Questions

For advice and assistance with topics not covered here, go to Autodesk Support,
click your product name, and search in the Knowledgebase for your product.

What if I have lost my serial number or
product key?

Check your product packaging or purchase records, if available, or contact
Autodesk Customer Service for assistance.
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Why do I need to activate a product after
installation?

Activation verifies for Autodesk and for you as a license holder that your
Autodesk product is installed on an eligible computer. The activation process
improves license security and management. For example, it ensures that a
multi-seat license is not in use by more than the authorized number of users.

How does a trial license work in a product
suite or bundle?

A single trial period, usually 30 days, applies to all Autodesk products in the
suite or bundle. When the first product is started, the trial period countdown
begins for all products. If the user does not activate one of the products before
the trial period ends, access to all of the products is denied. After the trial
period ends, the user can restore access to the products by entering an
activation code.

How do I switch my license from stand-alone
to network or network to stand-alone?

If you simply entered the wrong license type by mistake, and are still running
the installer, use the Back button to return to the Product Information dialog,
and change the license type.

If you want to change the license type for an installed product, contact your
Autodesk reseller or license supplier to obtain the new license and serial
number. Then uninstall your product and run a new install to change the
license type and enter the new serial number.
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After installation, how can I change product
configuration, repair, or uninstall the
product?

1 Go to the Windows control panel:
■ Windows XP: On the Start menu, click Settings ➤ Control

Panel ➤ Add or Remove Programs.

■ Windows Vista or 7: On the Start menu, click Settings ➤ Control
Panel ➤ Programs/Uninstall a Program.

2 In Windows control panel, click the product name, and then click
Change/Remove (Windows XP) or Uninstall/Change (Windows Vista
and 7).

The Installer opens in maintenance mode, and directs you through the
process.

General Installation Issues

This section outlines common issues and their solutions that may arise while
performing a general install of your product(s).

How can I check my graphics card driver to see if
it needs to be updated?

It is recommended that you verify and update your graphics card driver to
optimize your program. Use the following procedure to identify your current
graphics card driver.

To identify your graphics card driver on Windows

1 On the Start menu (Windows), click Settings  ➤  Control Panel.

2 Click the Display icon to access the Display Properties.

In Vista, click Settings  ➤  Control Panel  ➤  Personalization  ➤  Display
Settings.

3 Open the Settings tab and click the Advanced button.
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4 Click the Adapter tab to check the adapter type.

5 Click the Properties button and open the Driver tab to check driver
version and see if newer drivers are available.

TIP

Many newer graphic cards offer tabbed pages where you can learn more
precise information about your specific graphic card. If specific tab pages
are present, refer to them instead of the Adapter tab.

Where are my product manuals?

Documentation for Autodesk products are available in two formats: CHM and
HTML.
■ CHM files are available after the product is installed; they are accessed in

the Help menu in the product.

■ HTML files are available after the product is installed; they are accessed in
the Help menu in the product.

For late-breaking information see the product’s Readme file, on the product
disc. The Readme is also available from the Installation Complete page, or
through the Help system.

Where can I find product license information after
installation?

Select Help menu ➤ About, or About [Product Name]. If your product uses
InfoCenter, that is where you can find the Help menu.

Networking Issues

This section outlines common issues and their solutions with regards to
performing a network installation or configuring your network license server(s).
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Where do I find my server name on Windows?

When installing a network licensed product, you must specify the name of
the server that will run the Network License Manager. If you don’t know the
server name, you can quickly find it by opening a Windows command prompt
on the system that will be the Network License Manager. At the prompt, enter
ipconfig /all and note the Host Name entry.

Uninstall and Maintenance Issues

This section outlines common issues and their solutions with regards to adding
and removing features, reinstalling or repairing your installation, and
uninstalling products.

Uninstall and Maintenance Questions

How can I see what is included in a default
installation?

To see what is installed during a default installation, go through the installation
process to the Product Configuration page. The products selected here are
installed in a default installation. If you click a selected product box to open
the configuration panel, you can see the default settings for subcomponents
and features.

Is it possible to change the installation folder when
adding or removing features?

After your product is installed, you cannot change the installation path.
Changing the path while adding features results in program corruption, so it
is not an option.
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How do I install tools and utilities after installing
my product?

Run the installer again from the original media, and click Install Tools &
Utilities on the first screen. The installer guides you through the process of
selection, configuration and installation of tools and utilities.

When should I reinstall the product instead of
repairing it?

Reinstall your product if you accidentally delete or alter files that are required
by the program. Missing or altered files adversely affect the performance of
your product and cause error messages when you try to execute a command
or find a file.

If an attempt to repair an installation fails, reinstalling is the next best option.

Do I need the original media to reinstall my
product?

Yes. When reinstalling a product, you are prompted to load the original media.
If the product was installed from a network deployment, you need access to
the original deployment, unaltered by later changes such as the addition of
a service pack.

When I uninstall my software, what files are left
on my system?

If you uninstall the product, some files remain on your computer such as files
you created or edited (for example, drawings or custom menus).

Your license file also stays on your computer when you uninstall your product.
If you reinstall on the same computer, the license information remains valid;
you do not have to reactivate the product.
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activate Part of the Autodesk software registration process, it allows you to
run a product in compliance with the product's end-user license agreement.

administrative image A collection of shared file resources created by the
deployment process and used to install the program to network computers.

deployment The process of installing Autodesk products to one or more
computers on a network.

hot fix Autodesk terminology for a minor application patch that contains a
few code fixes.

installation image A deployment that consists of one or more MSI files and
their associated data files, any associated transforms, additional user-specified
custom files, profile, and registry settings.

language pack A set of installed files, used by some Autodesk products, that
enable the user to work in the application in the language specified by the
language pack.

language family A set of languages (core product, plus language packs) that
are distributed together, typically based on a geographic grouping. Languages
are not distributed in this way for all Autodesk products.

License Transfer Utility A tool used to transfer a stand-alone license for an
Autodesk product from one computer to another, using Autodesk servers.
Both the source and target computers require Internet access.

multi-seat stand-alone installation A type of installation in which multiple
stand-alone seats of the product are installed using a single serial number.

network license installation A type of installation in which the product is
installed on multiple computers, but the distribution of licenses is handled
by the Network License Manager.

patch A software update to an application.

service pack Autodesk terminology for a major application patch that typically
includes many code fixes.

silent mode An installation that proceeds without any explicit user input.
No dialog boxes are presented that require interaction from the user.
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